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1 About this guide

This guide describes how to migrate Sophos Enterprise Manager version 4.7 from one server to
another.

Enterprise Manager is a 32-bit application that can run on Windows 64-bit operating systems.
You may use this guide to migrate between any supported Windows operating system, 32-bit or
64-bit.
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2 Terminology

The following table lists terms that have specific meanings for this guide:

MeaningTerm

The existing Enterprise Manager (SEM) server.old server

A new server onto which the existing installation of Enterprise Manager
will be migrated.

new server

The old server's identification details: name, domain and IP address if
fixed.

old identity

A new server's new identification details: name, domain and IP address
if fixed. Name (and IP address) must differ from the old identity but
domain must be the same.

new identity
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3 Assumptions

This guide assumes the following:

■ You already have Enterprise Manager version 4.7 installed on the old server.

■ Both old and new servers are in the same domain or workgroup.

■ You have the necessary administrator privileges.
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4 Prepare for migration

4.1 Check Update Manager password

The Sophos Update Manager (SUM) password is set in updating policies and is used to authenticate
endpoints so that they can receive updates from SUM. Before you start migration, make sure that
you know your SUM password.

If you do not know your SUM password, you can reset it. You should be aware that if you do this,
your endpoint computers will fail authentication when they next update.

To reset your SUM password:

1. From Enterprise Manager, open your updating policy.

2. Go to Primary Server > Password > Change .

3. Set a new password.

4. Apply the policy to all endpoints (right-click on all groups then Comply with > All Group
Policies ).

5. Confirm that all endpoints are compliant with the revised updating policy (there are no
"Computers that differ from policy").

If you skip this step and do not know your SUM password then after migration you will need to
re-protect all endpoints.

4.2 Prepare the new server

Note: You can skip this section if you have not installed any Sophos products on the new server
previously.

If you are using a server that has had any Sophos products installed, ensure all the components
are uninstalled and do the following:

1. Take a backup of your registry.

For information on how to take a registry backup, refer to Microsoft documentation.

2. Ensure the Sophos Message Router service is not running:

a) Open Services by clicking Start, clicking Run, and then typing services.msc.

b) In the details panel, make sure that the Status column of the Sophos Message Router is
blank.

If the Status column is not blank, right-click Sophos Message Router, and then click Stop.

c) Close Services.

3. Open the Registry Editor by clicking Start, clicking Run, and then typing regedit.
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4. Browse to the registry key:

Registry key locationWindows
version

HKEY_LOCAL_MACHINE\SOFTWARE\Sophos32-bit

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Sophos64-bit

Delete the following sub registry folders, if they exist:

■ Messaging System

■ Remote Management System

Close the Registry Editor window.

5. Browse to the folder location:

Default installation pathWindows
version

C:\Program files\Sophos32-bit

C:\Program files (x86)\Sophos64-bit

Delete the folder 'Remote Management System' if it exists.
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5 Download software

Before you start, download the following software. You will need to enter your MySophos
credentials.

■ Sophos ExportPrivateStore utility [
https://secure.sophos.com/support/updates/dp/full/sec_eps_47_sfx.exe ] (to both old and new
servers)

■ Sophos Enterprise Manager 4.7 [ https://secure.sophos.com/support/updates/dp/full/sem_47_sfx.exe
] (to new server)
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6 Migrate Enterprise Manager

You can choose to migrate Enterprise Manager to a new server in two ways:

■ with a new identity; see Migrate with a new identity (page 9).

■ with the old identity; see Migrate with the old identity (page 17).

6.1 Migrate with a new identity
You can migrate Enterprise Manager to a new server with a new identity. To do so, carry out these
key steps:

■ Copy certificates from old to new server.

■ Install Enterprise Manager on the new server.

■ Export database, private store and registry keys from the old server.

■ Import database, private store and registry keys to the new server.

■ Switch endpoint computers to be managed by the new Enterprise Manager.

■ Switch endpoint computers to be updated by the new Update Manager.

6.1.1 Copy certificate registry keys

Copy the Sophos certificates registry keys from old to new servers as follows:

1. On the old server, click Start, Run, type regedit and then click OK.

The Registry Editor window is displayed.

2. Browse to the registry key:

Registry key locationWindows
version

HKEY_LOCAL_MACHINE\SOFTWARE\Sophos\Certification Manager32-bit

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Sophos\Certification
Manager

64-bit

3. Click File, click Export and save it. The certificates registry key is exported.

Note:  If you are migrating between 32-bit to 64-bit computers, you must edit the registry key.
For more information, see Modify exported registry files (page 25).
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4. On the new server, in the Registry Editor window, click File, Import to import the certificates
registry key.

A confirmation message will be displayed.

5. Browse to the registry key:

Registry key locationWindows
version

HKEY_LOCAL_MACHINE\SOFTWARE\Sophos\Certification Manager\CASerialNo32-bit

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Sophos\Certification
Manager\CASerialNo

64-bit

6. Edit the binary value called "Value" to add 1 to the second of the four octets.

For example: 43 F7 03 00 becomes 43 F8 03 00

Note:  If the octet is already at its maximum value, reset it to zero and add one to the next octet.
For example: 43 FF 07 00 becomes 43 00 08 00.

This will ensure serial numbers for endpoints will not conflict if the old and new servers are
running simultaneously.

7. Close the Registry Editor window.

6.1.2 Install Enterprise Manager

You must install Enterprise Manager with default configuration on the new server.

Note:  For more information on how to install, see the Enterprise Manager startup guide, available
from www.sophos.com/support/docs/Enterprise_Manager-all.html.

To install Enterprise Manager:

1. Find the Enterprise Manager installer that you downloaded earlier.

Tip:  The installer file name includes "sem".

2. Double-click the installer and click Install.

The installation files are copied to the server and an installation wizard starts.

3. In the Sophos Enterprise Manager dialog box, click Next.

4. A wizard guides you through installation. You should accept the defaults wherever possible.

5. When installation is complete, you may be prompted to restart. Click Yes or Finish.

6. When you log on again, cancel the Download Security Software wizard and close Enterprise
Manager.
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6.1.3 Export database, registry keys, and private store

To export the Sophos database, registry keys, and private store from the old server:

1. Go to the old server.

2. To make sure that no new information is written to the database whilst it is being exported,
stop the Sophos Message Router and Sophos Management Service services:

a) Click Start, Run, type services.msc and click OK.

b) In the Services window, right-click the service name and click Stop.

c) Close the Services window.

3. Run the ExportPrivate Store installer that you downloaded earlier, noting the installation folder.

4. Open a command prompt window at the directory where you installed the ExportPrivateStore
utility (default C:\sec_47\tools).

5. Export the Sophos private store by entering a command in this format:

ExportPrivateStore -s -e spstore.bak

If the command returns "ERROR: key not valid for use in specified state" then you need to run
ExportPrivateStore with elevated privileges. For information, see Run ExportPrivateStore with
elevated privileges (page 25).

6. Open Registry Editor.

To open Registry Editor, click Start, click Run, type regedit, and then click OK.

7. Browse to the registry key.

Registry key locationWindows
version

HKEY_LOCAL_MACHINE\SOFTWARE\Sophos\EE\Management Tools32-bit

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Sophos\EE\Management
Tools

64-bit

8. Click File, click Export and save it.

The registry key is exported. The key must be imported to the new server later.

Note:  If you are migrating between 32-bit to 64-bit computers, you must edit the registry key.
For more information, see Modify exported registry files (page 25).

9. Create a folder for the database backup, for example C:\SophosBackups.
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10. Open a command prompt at the Enterprise Manager installation database directory.

Default locationWindows
version

C:\Program Files\Sophos\Enterprise Manager\DB32-bit

C:\Program files (x86)\Sophos\Enterprise Manager\DB64-bit

11. Backup the database by entering a command in this format:
BackupDB C:\SophosBackups\SOPHOS.bak

If the SQL Server instance is anything other than SOPHOS, add its name, for example:

BackupDB C:\SophosBackups\SOPHOS.bak MySQLServerInstance

12. Copy the private store export file (C:\sec_47\tools\spstore.bak) to a folder on the new server,
for example C:\sec_47\tools.

13. Copy the registry hive file to a folder on the new server, for example C:\SophosBackups.

14. Copy the database backup file (C:\SophosBackups\SOPHOS.bak) to a folder on the new server,
for example C:\SophosBackups.

6.1.4 Import database, registry keys, and private store

To import the Sophos database, registry keys, and private store to the new server:

1. Go to the new server.

2. To make sure that no new information is written to the database whilst it is being imported,
stop the Sophos Message Router and Sophos Management Service services:

a) Click Start, click Run, type services.msc and click OK.

b) In the Services window, right-click the service name and click Stop.

c) Close the Services window.

3. Open a command prompt at the Enterprise Manager installation database directory.

Default locationWindows
version

C:\Program Files\Sophos\Enterprise Manager\DB32-bit

C:\Program files (x86)\Sophos\Enterprise Manager\DB64-bit

4. Import the database by typing RestoreDB C:\SophosBackups\SOPHOS.bak.
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5. Open Registry Editor.

To open Registry Editor, click Start, click Run, type regedit, and then click OK.

6. On the File menu, click Import.

7. Browse to the Management Tools hive file that you exported and copied in Export database,
registry keys, and private store (page 18).

8. In the left pane, select the key:

Registry key locationWindows
version

HKEY_LOCAL_MACHINE\SOFTWARE\Sophos\EE\Management
Tools\DatabaseConnectionMS

32-bit

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Sophos\EE\Management
Tools\DatabaseConnectionMS

64-bit

9. In the right pane, select the entry DatabaseConnectionMS.

10. On the Edit menu, click Modify.

11. In Value data, find your old server hostname, and then replace it with the new server hostname:
Data Source=hostname\SOPHOS.

12. If Sophos Update Manager uses a workgroup account, do the following:

a) In the right pane, select the entry SumUserName.

b) On the Edit menu, click Modify.

c) In Value data, find your old server hostname, and then replace it with the new server
hostname.

13. Modify the DatabaseUserDomain registry key to have the same value as the old server.

Registry key locationWindows
version

HKEY_LOCAL_MACHINE\SOFTWARE\Sophos\EE\Management
Tools\DatabaseUser

32-bit

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Sophos\EE\Management
Tools\DatabaseUser

64-bit

Note:  The username and password for updating policy will be obfuscated. For information
on how to view an obfuscated value, see
http://www.sophos.com/support/knowledgebase/article/13094.html.
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14. Edit the updating policy account details on the new server to match with the old server. To
edit the updating policy:

a) In the Enterprise Manager console, double-click on the updating policy you want to edit.

b) Select Primary server.

c) Modify the Username and Password.

d) If required, modify the settings for Secondary server.

15. Run the ExportPrivate Store installer that you downloaded earlier, noting the installation folder.

16. Open a command prompt window at the directory where you installed the ExportPrivateStore
utility (default C:\sec_47\tools).

17. Delete any existing private store by typing ExportPrivateStore -d.

Confirm by typing Y (uppercase).

18. Import the private store that you copied earlier by typing ExportPrivateStore -s -i spstore.bak.

If the command returns "ERROR: key not valid for use in specified state" then you need to run
ExportPrivateStore with elevated privileges. For information, see Run ExportPrivateStore with
elevated privileges (page 25).

19. Restart the Sophos Message Router and Sophos Management Service services on both the old
and new servers.

Note: Any alert messages that were sent to the old server since the Sophos Management Service
has been stopped on it (during registry back up) will be available once the services are restarted
on the old server. You may review them before decommissioning the old server.

6.1.5 Redirect endpoints to the new Enterprise Manager

You must configure endpoint computers to be managed by the Enterprise Manager installed on
the new server:

1. On the old server, create a batch file called "reinit.bat".

To create the batch file, open Notepad, copy-paste the code from the location mentioned below,
and save the file as reinit.bat.

http://www.sophos.com/sophos/docs/eng/migration/reinit.txt.

2. Create a configuration file called "sav.cfg".

To create a configuration file, open Notepad, copy-paste the code below, and save the file as
sav.cfg.

[Scripts]
ScriptFiles = reinit.bat, mrinit.conf
AfterScript = [None]"%ScriptPath%\reinit.bat"
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3. Copy the reinit.bat batch file and sav.cfg configuration files that have been created to the savxp
subfolder of every CID on the old server.

The default location is: C:\Document and Settings\All Users\Application Data\Sophos\Update
Manager\Update Manager\CIDs\Sxxx\SAVSCFXP\savxp

On Windows Server 2008, the default location is: C:\ProgramData\Sophos\Update
Manager\Update Manager\CIDs\Sxxx\SAVSCFXP\savxp

4. On the new server, copy the mrinit.conf file.

Default locationWindows
version

C:\Program Files\Sophos\Enterprise Manager32-bit

C:\Program files (x86)\Sophos\Enterprise Manager64-bit

5. Paste the mrinit.conf file to the savxp subfolder of every CID on the old server.

The default location is: C:\Document and Settings\All Users\Application Data\Sophos\Update
Manager\Update Manager\CIDs\Sxxx\SAVSCFXP\savxp

On Windows Server 2008, the default location is: C:\ProgramData\Sophos\Update
Manager\Update Manager\CIDs\Sxxx\SAVSCFXP\savxp

6. On the old server, run ConfigCID.exe with the local Subscription path for each CID. The
default location for ConfigCID.exe is:

Default locationWindows
version

C:\Program Files\Sophos\Update Manager32-bit

C:\Program Files (x86)\Sophos\Update Manager64-bit

For example:

ConfigCID.exe "C:\Documents and Settings\All Users\Application Data\Sophos\Update
Manager\Update Manager\CIDs\Sxxx\SAVSCFXP"

On Windows Server 2008: ConfigCID.exe "C:\ProgramData\Sophos\Update Manager\Update
Manager\CIDs\Sxxx\SAVSCFXP"
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7. Verify the program output is as follows:

Adding entry for \savxp\mrinit.conf

Adding entry for \mrinit.conf

Adding entry for \savxp\reinit.bat

Adding entry for \reinit.bat

Adding entry for \savxp\sav.cfg

Adding entry for \sav.cfg

The above output confirms that the file mrinit.conf was found and has been added to the
catalogue of files to be downloaded to your endpoints.

8. On the old server, open Enterprise Manager and update computers.

To update computers, right-click an endpoint computer/group and click Update computers
Now.

When the update is complete, endpoints will be managed by the new instance of Enterprise
Manager.

6.1.6 Redirect endpoints to the new Update Manager

You must configure endpoint computers to be updated by the new Update Manager and configure
SUM to download updates from Sophos.

1. On the new server open Enterprise Manager.

2. On the View menu, click Update managers.

The Update Managers list is displayed with the new Sophos Update Manager (SUM).

3. Double-click the old SUM and remove all entries on the Sources tab. Click OK.

4. Double-click the new SUM and setup the Sources, Subscriptions, Distributions, and other
details as required.

5. Wait until the Last Updated column changes from Never to the current date/time for the
new SUM.

6. On the View menu, click Endpoints and edit each of the updating policies to point the new
SUM.

7. On the View menu, click Update managers, in the update manager list, right-click the old
SUM and click Delete.

The old server may now be decommissioned. For information see, Decommission the old server
(page 24).
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6.2 Migrate with the old identity
You can migrate Enterprise Manager to a new server that retains the old identity on the same
Domain. To do so, carry out these key steps:

■ Export certificates from the old server.

■ Export database, private store and registry keys from the old server.

■ Copy the identity of old server.

■ Apply the old identity to the new server.

■ Install Enterprise Manager on the new server.

■ Import certificates to the new server.

■ Import database, private store and registry keys to the new server.

■ Obtain updating configuration.

6.2.1 Export certificates

Export the Sophos certificates from your old server as follows:

1. On the old server, click Start, click Run, type regedit and then click OK.

The Registry Editor window is displayed.

2. Browse to the registry key:

Registry key locationWindows
version

HKEY_LOCAL_MACHINE\SOFTWARE\Sophos\Certification Manager32-bit

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Sophos\Certification
Manager

64-bit

3. Click File, click Export and save it. The certificates registry key is exported.

Note:  If you are migrating between 32-bit to 64-bit computers, you must edit the registry key.
For more information, see Modify exported registry files (page 25).

4. Close the Registry Editor window and copy the certificates export file to the new server.
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6.2.2 Export database, registry keys, and private store

To export the Sophos database, registry keys, and private store from the old server:

1. Go to the old server.

2. To make sure that no new information is written to the database whilst it is being exported,
stop the Sophos Message Router and Sophos Management Service services:

a) Click Start, Run, type services.msc and click OK.

b) In the Services window, right-click the service name and click Stop.

c) Close the Services window.

3. Run the ExportPrivate Store installer that you downloaded earlier, noting the installation folder.

4. Open a command prompt window at the directory where you installed the ExportPrivateStore
utility (default C:\sec_47\tools).

5. Export the Sophos private store by entering a command in this format:

ExportPrivateStore -s -e spstore.bak

If the command returns "ERROR: key not valid for use in specified state" then you need to run
ExportPrivateStore with elevated privileges. For information, see Run ExportPrivateStore with
elevated privileges (page 25).

6. Open Registry Editor.

To open Registry Editor, click Start, click Run, type regedit, and then click OK.

7. Browse to the registry key.

Registry key locationWindows
version

HKEY_LOCAL_MACHINE\SOFTWARE\Sophos\EE\Management Tools32-bit

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Sophos\EE\Management
Tools

64-bit

8. Click File, click Export and save it.

The registry key is exported. The key must be imported to the new server later.

Note:  If you are migrating between 32-bit to 64-bit computers, you must edit the registry key.
For more information, see Modify exported registry files (page 25).

9. Create a folder for the database backup, for example C:\SophosBackups.
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10. Open a command prompt at the Enterprise Manager installation database directory.

Default locationWindows
version

C:\Program Files\Sophos\Enterprise Manager\DB32-bit

C:\Program files (x86)\Sophos\Enterprise Manager\DB64-bit

11. Backup the database by entering a command in this format:
BackupDB C:\SophosBackups\SOPHOS.bak

If the SQL Server instance is anything other than SOPHOS, add its name, for example:

BackupDB C:\SophosBackups\SOPHOS.bak MySQLServerInstance

12. Copy the private store export file (C:\sec_47\tools\spstore.bak) to a folder on the new server,
for example C:\sec_47\tools.

13. Copy the registry hive file to a folder on the new server, for example C:\SophosBackups.

14. Copy the database backup file (C:\SophosBackups\SOPHOS.bak) to a folder on the new server,
for example C:\SophosBackups.

6.2.3 Copy the identity of the old server

Copy the old server's identity as follows:

1. Go to the old server.

2. Open Windows Control Panel.

3. Note the following values from the System and Network applets: computer name, domain
and IP address (if fixed).

4. Shut down the server.

Note:  If you have to restart the old server, ensure it is not connected to the network until you
give it a new identity (name and IP address).

6.2.4 Apply the old identity to the new server

Apply the old identity to the new server as follows.

1. Ensure the old server is turned off.

2. Go to the new server.

3. Open Windows Control Panel.
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4. Set the following values to the old identity using the System and Network applets: computer
name, domain and IP address (if fixed).

For information on how to change IP address, Computer and Domain Names, see Microsoft
documentation.

6.2.5 Import certificates

Import the Sophos certificates to the new server as follows:

1. On the new server, click Start, click Run, type regedit and then click OK.

2. In the Registry Editor window, click File, click Import and choose the certificates export file.

A confirmation message will be displayed.

3. Close the Registry Editor window.

6.2.6 Install Enterprise Manager

You must install Enterprise Manager with default configuration on the new server.

Note:  For more information on how to install, see the Enterprise Manager startup guide, available
from www.sophos.com/support/docs/Enterprise_Manager-all.html.

To install Enterprise Manager:

1. Find the Enterprise Manager installer that you downloaded earlier.

Tip:  The installer file name includes "sem".

2. Double-click the installer and click Install.

The installation files are copied to the server and an installation wizard starts.

3. In the Sophos Enterprise Manager dialog box, click Next.

4. A wizard guides you through installation. You should accept the defaults wherever possible.

5. When installation is complete, you may be prompted to restart. Click Yes or Finish.

6. When you log on again, cancel the Download Security Software wizard and close Enterprise
Manager.
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6.2.7 Import database, registry keys, and private store

To import the Sophos database, registry keys, and private store to the new server:

1. To make sure that no new information is written to the database whilst it is being imported,
stop the Sophos Message Router and Sophos Management Service services:

a) Click Start, click Run, type services.msc and click OK.

b) In the Services window, right-click the service name and click Stop.

c) Close the Services window.

2. Open a command prompt at the Enterprise Manager installation database directory.

Default locationWindows
version

C:\Program Files\Sophos\Enterprise Manager\DB32-bit

C:\Program files (x86)\Sophos\Enterprise Manager\DB64-bit

3. Import the database by typing RestoreDB C:\SophosBackups\SOPHOS.bak.

4. Open Registry Editor.

To open Registry Editor, click Start, click Run, type regedit, and then click OK.

5. On the File menu, click Import.

6. Browse to the Management Tools hive file that you exported and copied in Export database,
registry keys, and private store (page 18).

7. In the left pane, select the key:

Registry key locationWindows
version

HKEY_LOCAL_MACHINE\SOFTWARE\Sophos\EE\Management
Tools\DatabaseConnectionMS

32-bit

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Sophos\EE\Management
Tools\DatabaseConnectionMS

64-bit

8. In the right pane, select the entry DatabaseConnectionMS.

9. On the Edit menu, click Modify.

10. In Value data, find your old server hostname, and then replace it with the new server hostname:
Data Source=hostname\SOPHOS.
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11. If Sophos Update Manager uses a workgroup account, do the following:

a) In the right pane, select the entry SumUserName.

b) On the Edit menu, click Modify.

c) In Value data, find your old server hostname, and then replace it with the new server
hostname.

12. Modify the DatabaseUserDomain registry key to have the same value as the old server.

Registry key locationWindows
version

HKEY_LOCAL_MACHINE\SOFTWARE\Sophos\EE\Management
Tools\DatabaseUser

32-bit

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Sophos\EE\Management
Tools\DatabaseUser

64-bit

Note:  The username and password for updating policy will be obfuscated. For information
on how to view an obfuscated value, see
http://www.sophos.com/support/knowledgebase/article/13094.html.

13. Edit the updating policy account details on the new server to match with the old server. To
edit the updating policy:

a) In the Enterprise Manager console, double-click on the updating policy you want to edit.

b) Select Primary server.

c) Modify the Username and Password.

d) If required, modify the settings for Secondary server.

14. Run the ExportPrivate Store installer that you downloaded earlier, noting the installation folder.

15. Open a command prompt window at the directory where you installed the ExportPrivateStore
utility (default C:\sec_47\tools).

16. Delete any existing private store by entering the following command:

ExportPrivateStore -d

Confirm by entering Y (uppercase).

If the command returns "ERROR: key not valid for use in specified state" then you need to run
ExportPrivateStore with elevated privileges. For information, see Run ExportPrivateStore with
elevated privileges (page 25).

17. Import the private store that you copied earlier by entering a command in this format:

ExportPrivateStore -s -i spstore.bak
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18. Restart the Sophos Message Router and Sophos Management Service services on the new server.

6.2.8 Obtain updating configuration

To obtain updating configuration:

1. On the new server open Enterprise Manager.

2. On the View menu, click Update managers.

The Update Managers list is displayed.

3. Right-click the SUM and click Comply with Configuration.

The new server will obtain the configuration.

The migration is now complete and the old server can be decommissioned.
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7 Decommission the old server

1. If you are disposing of the old server, it is advisable to securely wipe or destroy its hard drive(s).

2. If you are reusing the old server, uninstall Enterprise Manager using Windows Control Panel.
If you have migrated with the old identity, give the old server a new identity before reconnecting
it to your network.
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8 Appendices

8.1 Run ExportPrivateStore with elevated privileges

On systems using Active Directory, you may need to run the ExportPrivateStore utility with
elevated domain privileges.

To run ExportPrivateStore with elevated privileges:

1. Log on to the server locally as a member of the Administrators group.

Note:  The procedure described here will not work if you log on to the server using Remote
Desktop or Terminal Client.

2. Open the Command Prompt window.

3. Type sc create "LocalSystem Command Prompt" binpath= "cmd.exe /K start" type= own
type= interact.

You can safely ignore any warnings that may appear.

This command creates a temporary service with Local System privileges. The Local System
account is a powerful account that has full access to the system, including the directory service
on domain controllers.

4. Type sc start "LocalSystem Command Prompt".

This command starts the temporary service and opens a special LocalSystem Command Prompt
window that has elevated domain privileges.

5. At the LocalSystem command prompt, change to the ExportPrivateStore installation directory
by typing cd c:\sec_47\tools.

6. Type the ExportPrivateStore command.

7. When you have finished, close the LocalSystem Command Prompt window.

8. At the command prompt, delete the temporary service by typing sc delete "LocalSystem
Command Prompt".

9. Close the Command Prompt window.

8.2 Modify exported registry files

Enterprise Manager is a 32-bit application that can run on Windows 64-bit operating systems.

If you are migrating between 32-bit and 64-bit machines, when exporting and importing registry
keys, you will need to open any exported registry files in a text editor and change the Sophos
registry values as shown below. The easiest and most reliable way to do this is by using search and
replace.
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Sophos registry locationDefault
installation path

Windows
version

HKEY_LOCAL_MACHINE\SOFTWARE\SophosC:\Program files32-bit

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SophosC:\Program files
(x86)

64-bit

Migrating from a 32-bit to 64-bit computer

1. Open the saved registry exported file with Windows Notepad.

2. Click on the Edit menu and click Replace.

3. In Find what type \SOFTWARE\Sophos\ and in Replace with type
\SOFTWARE\Wow6432Node\Sophos\.

4. Click Replace all.
5. In Find what type C:\\Program Files\\Sophos\\Enterprise Manager\\SUMInstaller and in

Replace with type C:\\Program Files (x86)\\Sophos\\Enterprise Manager\\SUMInstaller.

6. Click Replace all
7. Save the file and close Notepad.

Migrating from a 64-bit to 32-bit computer

1. Open the saved registry exported file with Windows Notepad.

2. Click on the Edit menu and click Replace.

3. In Find what type \Wow6432Node\Sophos\ and in Replace with type \Sophos\.
4. Click Replace all.
5. In Find what type C:\\Program Files (x86)\\Sophos\\Enterprise Manager\\SUMInstaller and

in Replace with type C:\\Program Files\\Sophos\\Enterprise Manager\\SUMInstaller.

6. Click Replace all
7. Save the file and close Notepad.
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9 Technical support

You can find technical support for Sophos products in any of these ways:

■ Visit the SophosTalk community at http://community.sophos.com/ and search for other users
who are experiencing the same problem.

■ Visit the Sophos support knowledgebase at http://www.sophos.com/support/.

■ Download the product documentation at http://www.sophos.com/support/docs/.

■ Send an email to support@sophos.com, including your Sophos software version number(s),
operating system(s) and patch level(s), and the text of any error messages.
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10 Legal notices

Copyright © 2011 Sophos Limited. All rights reserved. No part of this publication may be
reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic,
mechanical, photocopying, recording or otherwise unless you are either a valid licensee where the
documentation can be reproduced in accordance with the license terms or you otherwise have
the prior permission in writing of the copyright owner.

Sophos and Sophos Anti-Virus are registered trademarks of Sophos Limited. All other product
and company names mentioned are trademarks or registered trademarks of their respective owners.

ACE™, TAO™, CIAO™, and CoSMIC™

ACE1, TAO2, CIAO3, and CoSMIC4 (henceforth referred to as “DOC software”) are copyrighted
by Douglas C. Schmidt5 and his research group6 at Washington University7, University of
California8, Irvine, and Vanderbilt University9, Copyright © 1993–2005, all rights reserved.

Since DOC software is open-source, free software, you are free to use, modify, copy, and
distribute–perpetually and irrevocably–the DOC software source code and object code produced
from the source, as well as copy and distribute modified versions of this software. You must,
however, include this copyright statement along with code built using DOC software.

You can use DOC software in commercial and/or binary software releases and are under no
obligation to redistribute any of your source code that is built using DOC software. Note, however,
that you may not do anything to the DOC software code, such as copyrighting it yourself or
claiming authorship of the DOC software code, that will prevent DOC software from being
distributed freely using an open-source development model. You needn’t inform anyone that
you’re using DOC software in your software, though we encourage you to let us10 know so we can
promote your project in the DOC software success stories11.

DOC software is provided as is with no warranties of any kind, including the warranties of design,
merchantability, and fitness for a particular purpose, noninfringement, or arising from a course
of dealing, usage or trade practice. Moreover, DOC software is provided with no support and
without any obligation on the part of Washington University, UC Irvine, Vanderbilt University,
their employees, or students to assist in its use, correction, modification, or enhancement. A
number of companies12 around the world provide commercial support for DOC software, however.
DOC software is Y2K-compliant, as long as the underlying OS platform is Y2K-compliant.

Washington University, UC Irvine, Vanderbilt University, their employees, and students shall
have no liability with respect to the infringement of copyrights, trade secrets or any patents by
DOC software or any part thereof. Moreover, in no event will Washington University, UC Irvine,
or Vanderbilt University, their employees, or students be liable for any lost revenue or profits or
other special, indirect and consequential damages.

The ACE13, TAO14, CIAO15, and CoSMIC16 web sites are maintained by the DOC Group17 at the
Institute for Software Integrated Systems (ISIS)18 and the Center for Distributed Object Computing
of Washington University, St. Louis19 for the development of open-source software as part of the
open-source software community20. By submitting comments, suggestions, code, code snippets,
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techniques (including that of usage), and algorithms, submitters acknowledge that they have the
right to do so, that any such submissions are given freely and unreservedly, and that they waive
any claims to copyright or ownership. In addition, submitters acknowledgethat any such submission
might become part of the copyright maintained on the overall body of code, which comprises the
DOC software. By making a submission, submitter agree to these terms. Furthermore, submitters
acknowledge that the incorporation or modification of such submissions is entirely at the discretion
of the moderators of the open-source DOC software projects or their designees.

The names ACE, TAO, CIAO, CoSMIC, WashingtonUniversity, UC Irvine, and Vanderbilt
University, may not be used to endorse or promote products or services derived from this source
without express written permission from Washington University, UC Irvine, or Vanderbilt
University. Further, products or services derived from this source may not be called ACE, TAO,
CIAO, or CoSMIC nor may the name Washington University, UC Irvine, or Vanderbilt University
appear in their names, without express written permission from Washington University, UC
Irvine, and Vanderbilt University.

If you have any suggestions, additions, comments, or questions, please let me21 know.

Douglas C. Schmidt22
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Apache

The Sophos software that is described in this document may include some software programs that
are licensed (or sublicensed) to the user under the Apache License. A copy of the license agreement
for any such included software can be found at http://www.apache.org/licenses/LICENSE-2.0.

Common Public License

The Sophos software that is referenced in this document includes or may include some software
programs that are licensed (or sublicensed) to the user under the Common Public License (CPL),
which, among other rights, permits the user to have access to the source code. The CPL requires
for any software licensed under the terms of the CPL, which is distributed in object code form,
that the source code for such software also be made available to the users of the object code form.
For any such software covered under the CPL, the source code is available via mail order by
submitting a request to Sophos; via email to support@sophos.com or via the web at
http://www.sophos.com/support/queries/enterprise.html. A copy of the license agreement for any
such included software can be found at http://opensource.org/licenses/cpl1.0.php

ConvertUTF

Copyright 2001–2004 Unicode, Inc.

This source code is provided as is by Unicode, Inc. No claims are made as to fitness for any
particular purpose. No warranties of any kind are expressed or implied. The recipient agrees to
determine applicability of information provided. If this file has been purchased on magnetic or
optical media from Unicode, Inc., the sole remedy for any claim will be exchange of defective
media within 90 days of receipt.

Unicode, Inc. hereby grants the right to freely use the information supplied in this file in the
creation of products supporting the Unicode Standard, and to make copies of this file in any form
for internal or external distribution as long as this notice remains attached.

iMatix SFL

This product uses parts of the iMatix SFL, Copyright © 1991-2000 iMatix Corporation
http://www.imatix.com.

OpenSSL cryptographic toolkit

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License
and the original SSLeay license apply to the toolkit. See below for the actual license texts. Actually
both licenses are BSD-style Open Source licenses. In case of any license issues related to OpenSSL
please contact openssl-core@openssl.org.

OpenSSL license

Copyright © 1998–2011 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:
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1. Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgment:

“This product includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit. (http://www.openssl.org/)”

4. The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or promote
products derived from this software without prior written permission. For written permission,
please contact openssl-core@openssl.org.

5. Products derived from this software may not be called “OpenSSL” nor may “OpenSSL” appear
in their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:

“This product includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit (http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY EXPRESSED
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This
product includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay license

Copyright © 1995–1998 Eric Young (eay@cryptsoft.com) All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The
implementation was written so as to conform with Netscape’s SSL.

This library is free for commercial and non-commercial use as long as the following conditions
are adhered to. The following conditions apply to all code found in this distribution, be it the RC4,
RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this
distribution is covered by the same copyright terms except that the holder is Tim Hudson
(tjh@cryptsoft.com).

Copyright remains Eric Young’s, and as such any Copyright notices in the code are not to be
removed. If this package is used in a product, Eric Young should be given attribution as the author
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of the parts of the library used. This can be in the form of a textual message at program startup
or in documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement:

“This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)”

The word “cryptographic” can be left out if the routines from the library being used are not
cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory
(application code) you must include an acknowledgement:

“This product includes software written by Tim Hudson (tjh@cryptsoft.com)”

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

The license and distribution terms for any publically available version or derivative of this code
cannot be changed. i.e. this code cannot simply be copied and put under another distribution
license [including the GNU Public License.]
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